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System Requirement for Outlook Email Archive:

Macintosh with MacOs from 8.5 up to 9.1
Microsoft Outlook Express from 5.0 to 5.02

Many thanks to Prof. W. Douglas Carden for help in the manual.
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Quick Start

Welcome to Qutlook Email Archive (OEA), the simplest and quickest way to
archive your email messages.

Launch Microsoft Outlook Express.

Launch OEA (Outlook Email Archive). A main window appears:

Click on the top-left icon. @
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The folders and subfolders of your Microsoft Outlook program will be
loaded in the popup menu in the same sequence and positions as they are
in your application. At this point select the folder that you want to archive.
Into the last textbox, “Destination folder for Archive” drag the main folder
that will be used for the final destination of your archive.

You can also click on the left icon and the standard dialog box for choosing
a folder will appear.

At this point click “Process” and OEA will start the archiving process and
show you the progress of the operation.

Preface

Outlook Email Archive can archive your email in three different ways:

Archive email and/or attachments in the Finder.

1 - Archive Emails + attachments
2 - Only Emails
3 - Only attachments

Export or append email in a text file that can be read by a text editor or
a word-processing program.

4 - Export new text file
5 - Append to text file

Export or append email in tab-text format that can be imported, for
example, in FileMaker Pro. For this export function a free template is
enclosed in the “Extra” folder in the Outlook Email Archive folder.

6 - Export new tab-text file
7 - Append to tab-text file

Settings 1,2,3 produce produce a Finder-structured-folders archive where
emails and/or attachments are grouped by day (see next pages for more
details).

Settings 4 and 5 produce a long “paper trail” file that can be viewed with a
robust text editor like BBEdit or Text-Edit Plus (SimpleText can read a
maximum file size of 32 KB)

Settings 6 and 7 produce a tab-text file that can be imported into computer
database programs, including one of the best known database programs
for the Macintosh platform, Filemaker Pro.

With the first three kinds of archives OEA can recognize if one email has
been exported. In the Log there is the line “Skipped emails (already
archived)."

When using other kinds of archives, OEA always exports all emails found.
The best solution is to delete email from Outlook after it is archived
(automatic delete of emails are in development and scheduled in the future
versions of OEA).



Using Outlook Email Archive

After you launch OEA the main window appears.

On the top you can find the Outlook icon. Click on it to load the structure of
folders and subfolders of OQutlook into the popup menu “Source Folder”.
The user can include all subfolders by clicking the checkbox “include
Subfolders”.

The checkbox “All Structure” is for archiving the complete Outlook Express
structure.
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In the Destination box, the user can select the main folder or file
(depending on which Preferences have been chosen).
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About “Include Subfolders” and “All Structure”

Depending on which of the three types of archive the user selects, the
folder and its contents may be treated differently. If the user selects the
type of archive that produces “Finder structured” folders, and if the user
selects one Outlook Express folder without subfolders, then the contents of
this Outlook Express folder will be saved directly into the output folder
destination.

However, when the chosen folder contains subfolders or when

“All Structure” is selected, the complete Outlook Express structure
(including the main folder chosen) will be saved into the output folder
destination.

Remember this for a correct output destination structure if you choose
settings 1, 2 or 3.



Preferences

Before using Outlook Email Archive (OEA), chose Preferences from File
Menu.

The are four tabs: General, Folders, Tab Text and Filters.

Preferences
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Type of Archive (General Preferences)

The first three choices (Emails + attachments - Only emails - Only
Attachments) produce a “Finder Archive”, a structure of folders and
subfolders where the emails are stored by day of the year and time of the
day. For browsing this kind of archive | use and recommend to using
Sherlock (refer to page 12 for more information).

In this example the structure of folders and subfolders of Microsoft
Outlook Express is shown.
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When first using Outlook Email Archive | suggest creating the same

structure of folders and subfolders in the “Finder” that are in Microsoft
Outlook. (but this structure can be created automatically if you set “All
Structure”). Later simply drag and drop the destination folder from the

Finder to the “Destination folder for Archive” textbox in OEA’s main palette.

(See page 4 for more info...)

The resulting Finder archive will be like the one in the following example:
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All emails are grouped by day. In the example, the number (089) before the
date 29 March 2000 indicates the progressive number of the day of the
year (from 1 to 365 or 366); inside this folder, you will find all emails
received that day with the “Outlook ID Message” and the email (received or
sent) time. At this level OEA saves the email + attachments.

The other two choices from the popup menu are for archiving only emails
or only attachments.

Emails are saved with the creator chosen. Attachments are saved in the
original format (Stuffit, Compact Pro, native files...).

For browsing your email archive you can use Apple Sherlock Technology
and search inside the selected folder previously indexed for search in the
contents (refer to page 12 for more information).



Export new text file - Append to text file...

When the command “Export new text file” is selected, a blank destination
file is created (click on the icon file on main OEA window) and then filled
with the entire contents of the email messages:

O mport 1.3 =——H0 =

Folder : Macromedia E
From : John Smith jsrnith@rnacromedia.com

To: Stefano Cappello capste@libera.it, Frank Ross f.ross@apple.corn
Ce: Mark Nable ranoble@aal.com

B :

Cate: Sunday, 14 May 2000 123057

dttachrnents: Flash 4.0 se4

Sub ject: Beta Wersion of Flash 4.0

Hello Stefana,

Thiz numbetr will alzo route to ey phone mail.

My biggest concern is tirne zone differences.

REight now there is @ hours tirme difference between Santa Monica
and rmost cities in Haly. If ywou happen to hawve daylight sawving time,
the time differences is 10 hours.

Bwe

John Srnith

S ]

When the command “Append to text file...” is chosen, OEA appends the
email messages to the end of messages in an existing file.

Export new tab-text file - append to tab-text file

The command Export tab-text file is for generating a text file useful for
importing data into a database like, for example, FileMaker Pro.

A free template for FileMaker Pro 4 and 5 is included (in the folder “Extra”)
and is “open.” Users can change or modify the scripting and layout.
Before importing data into FileMaker it is important to select from the
popup menu of FileMaker Pro the command “Tab-Separated Text” as in
the following example:

| = Power 7500 | % | = Power 7500
[ Applications [ Eject ]
[5 Binuscan
&Z| From John Smith txt _Desktop_|
) Games |  Hosts |
[ Internet
- [ Cancel I
A4 || Open ||
Show: |Tab=Separated Text v

The following fields are exported:

Folder: the name of the folder or sub-folder where email is located.
From: the sender of email (display name and email).

To: list of addresses (display name and email separated by commas).
Cc: list of addresses (display name and email separated by commas).
Bec: list of addresses (display name and email separated by commas).
Date: the date of email received or sent.

Attachments: the list of attachments (separated by commas).

Subject: the subject of email.

Body: the content of email.



Import Field Mapping

Cata in: “Export 16 3054 (tab-text)
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Important Note:

The length of FileMaker Pro text fields are limited to 64 KB.

Append to tab-text file.

When the command “Append to tab-text file...” is chosen, OEA appends

the email messages to the end of the file.

About FileMaker Pro Template

The templates inside the folder “Extra” can be used for archiving all emails
exported with the function “Export tab-text file”.

The templates are in FileMaker Pro, versions 4 and 5.

Because FM Pro can manage dates in two different ways when the user
enters data from the keyboard (as mm-dd-yyy or dd-mm-yyyy, according
to the language and settings of your MacOs) it is necessary before using
the template to follow these steps:

You need this only the first time to initialize correctly the FM Pro document.

1. Open the template in FileMaker Pro.

2. Choose from File menu the command “Save a Copy As...”

3. Rename the file and choose from the popup menu the option “clone (no
records)”

This command changes the internal setting of the template concerning the
entry of some values like “Date”.

4. Close and open the new saved template.

5. Create a new record and type in the field “Date” the “Christmas of
December 2000” date as you usually type in Filemaker Pro (according to
the language and settings of your MacOs).

6. Press enter.

7. Because the field date is formatted to show the date as “dd Month
yyyy,” if you see 25 December 2000 (in your language), all is OK.

8. Delete this record and import the data exported from OEA (please check
the exporting settings in the “Preferences” window.



Creator for saved files (General Preferences)

All text files saved (including Log, Log Errors and all emails) will be saved
with the creator choosen.
The list of creator choices is as follows:

SimpleText
BEEdit

Tex-Edit Plus
Applellorks
Microsoft Word
Alpha

Archive using (General Preferences)

From the popup menu “Archive using” choose “Received date” or “Sent
date” for archiving/exporting email. The default choice is “Received date”.

+ RBeceived date (Default)
S5ent date

Important Note:

If you import emails from Microsoft Outlook Express 4.5 the received
dates are reset at the moment of the operation.

To check on this “Microsoft Bug” you can include a “Received Date
column” from the View menu in Microsoft Outlook Express.

Date format for Finder Archive (Folder Prefs)

Preferences

{ General "_I.,.-" F-:-IdersVTab TextVFilter’s\

[rate forrat for Finder archive

| (008) 8 January 2001 2]

You can set the date format for the folders (of day) created with the
following types of archives:

Emails + attachments
Only Emails
Only attachments

by choosing from the popup menu one of the following five settings:

~ (008) 8 January 2001

(008) 08 January 2001
(008) 08 Jan 2001
2001-01-08 (yyyy-mm-dd)
08-01-2001 [mm—dd—w]




Date format for tab-text file (Tab Text Prefs)

Preferences

J.-"r Generalv Falders \'I.U-"rTab Text \J.-"rFiIt-e-r'S \

Date forrmat for tab text file

[Munth—l]ag—'n'ear i]

In the popup menu “Date format for tab-text file” choose the correct
setting for your FileMaker Pro archive. Two settings are available:

+ Month-Day-Year
Day-Month-Year

Month-Day-Year (USA format)
Day-Month-Year (Euro - Rest of the World format)

Example:

Choosing the first setting (USA) results in the email date 14 May 2000,
being written to tab-text file as 5-14-2000.

Choosing the second setting (Euro) results in the date being written as
14-5-2000.

This is important for correct import of data into FileMaker Pro archives.
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Log

Every time Outlook Email Archive processes a folder, it writes a Log

file. The Log file is a text file showing the user the history of

tasks executed by OEA. It is possible to see the log by choosing “Show

Log” from the File menu of Outlook Email Archive.

DELDQ

=)=

Start process: Friday, January 12, 2001 02:12:07 PM
Type of drchive: Emails + attachments

Date: Friday, January 12, 2001 02:12:07 PM
Archived folder | Personal

Murnber of messages found: 0

Meszages archived: O

Skipped ernails Calready archived): 0

Date: Friday, January 12, 2001 02:13:05 PM
Archived folder : Friends

Murnber of messages found: 224

Meszages archived: 224

Skipped ernails Calready archived): 0

Date: Friday, January 12, 2001 0213 46 PM
Archived folder : eBoaok

Murnber of messages found: 192

Meszages archived: 192

Skipped ernails Calready archived): 0

Date: Friday, January 12, 2001 02:14:07 PM
Archived folder : Quark

Murnber of messages found: 68

Messzages archived: 68

Skipped ernails Calready archived): 0

Date: Friday, January 12, 2001 02:14 20 PM
Archived folder: Technical

Murnber of messages found: 52

Meszages archived: 52

Skipped ernails Calready archived): 0

End process: Friday, January 12, 2001 02:14 220 PrM

Total process tiene: Q000213

:k:k::R:k:k::k:k:k::k:k:k::k:k:k::k:k:ﬁ::R:k:k::k:k:k::k:k:ﬁ::k:k:ﬁ::k:k:k:k:k:\i

S




Using Sherlock to browse archives

The internal Apple Search Engine called Sherlock, can perform search
functions inside the contents of files. This means that it is possible (after
indexing) to search every kind of information on archives with
Finder-structured folders created with Outlook Email Archive.

| suggest storing your archive as a Disk image created with Apple Disk
copy or on media like Jaz, Zip or on a dedicated partition on your Hard
Disk. This is because the process of indexing is related to the entire disk
and if you put your archive on your Hard Disk you need to index the entire
disk (you cannot chose to index only some folders...)

Searching for some emails (using the “find by content” feature) is very fast
on the indexed disks. Sherlock stores the invisible index file inside the disk
itself, thus when you copy the disk image file (or take your Jaz, Zip,
PocketDrive), you will copy the index automatically and you will not have to
re-index your data again.

In this way, your archive is independent and you can copy it to another
Mac and perform every kind of searching... using Apple Sherlock.

Of course, you have to update your Sherlock index every time you perform
a new “Archiving” from OEA but this is a very fast procedure (and this
operation can be scheduled at predefined intervals).

After you have exported data from your Outlook with OEA using one of the
first three kinds of archives you have created a Finder-structured-folders
archive. | think this kind of archive is best for History archives. By History |
mean that you don’t need to have thousands of Outlook emails online,
because when you want to search one specific email you can do this using
the quickest possible way: Sherlock.

Index your archive by following the instructions in the Apple Help.

After having done this, you can ask to Sherlock to find every email that
contains specific words. In my Examples | have created a query for
searching every email that contains the words Quark and ATM.

Because Sherlock performs the search using the term OR between search
words, the results are shown by relevances: long progress bars mean that
Sherlock has found all the words requested. Short bars mean that emails
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contains not all words requested. You can perform many types of queries
like:

Search all email sent from John Smith regarding Quark and ATM or
Search all email sent from John Smith in December.

You can also perform the search only on some folders of your archive:
simply drag onto the Sherlock window the folder (in my example Sent)
where you want execute the searching (you can drag and drop more than
one folder) and perform the search on every folder or volume (like disks)
you want.



Sherlock Examples
Query with “Kodak” and “dcs” and “tiff” on entire disk “My Archive”.

r

Sherlock 2

=02 (%6 ¢ /MK

[kodak des tiff

() File Names

On
O = 0:91T4
O g 0s9UsA

™) My Archive

#® Contents

4 [ Edit... |

O [ Custom...

I ndex Status I

Wolume is not indexed
Wolume is not indexed
Yolume indexed Sunday, December 31, 2000, 18:59

Find items whose file name contains “kedak dos tiff *

Result of query (long progress bars mean that Sherlock has found all the

word

r

S requested).

Sherlock 2

SICINEICIOIC IS

@

Date Modified | =)

[kodak des tiff

() File Names @ Contents () [ Custom... %[ Edit... |
. e SimpleText text document
Re- TIFF PPD — | SimpleText text document
Re- &lso an another question = SimpleText text document
Re- #lso an another question = SimpleText text document
Re- Info Request = SimpleText text document
Re- Mo subject was specified. = SimpleText text document

Sun, Dec 31, 2000, 16:12 |=|
Sun, Dec 31, 2000, 16:17 | |
Sun, Dec 31, 2000, 16:15
Sun, Dec 31, 2000, 16:15
Sun, Dec 31, 2000, 16:15
Sun, Dec 31, 2000, 16:16

= My Archive
m Corrispondenza

E‘j Technical

5§ ¢248) D45ep 2000

G ¢3502) Time 11.57.45
New Kodak Photo. Camera Users!l]
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Query with “Quark” and “ATM” on folder “Sent ltems” of disk “My Archive”.

r

Sherlock 2

=(o/al

%G [é (IR

[quark ATM

() File Names

@ Contents

2 [ Edit... |

& [ Custom...

[ ]
Q@

On

Index Status I

O = 0:91T4
O = 0s9Us
O My &rchive
[ Ei Sent Items

Wolurne is not i ndexed
Wolume is not indexed
Wolume indexed Sunday, Decernber 31, 2000, 18:59
Yolume indexed Sunday, December 31, 2000, 15:59

Find items whose contents include "Quark ATM*

Result of query (long progress bars mean that Sherlock has found all the

words requested).

Sherlock 2

e’

%6 |é (IR

[ ]

[Quark ATM

() File Names @ Content:

% [ Edit... |

s [ Custom...

Hame

Kind

Date Modified

Fiaf - Problem with ATM Deluxe

Re- ATM Deluxe

Re- Q=P Mac 4.11 and usage
Emails da Quark

Re- QUARK CATALOGING

Re- Quark Express extension

SimpleText text document
SimpleText text document
SimpleText text document
SimpleText text document
SimpleText text document

SimpleText text document

Sun, Dec 31, 2000,
Sun, Dec 31, 2000,
Sun, Dec 31, 2000,
Sun, Dec 31, 2000,
Sun, Dec 31, 2000,
Sun, Dec 31, 2000,

= My Archive
Ei Sent Items
B (033) 02 Feb 2000
G ¢185) Time 12.51.51
Fitf- Problem with

ATHM Deluxe




Tips for Microsoft Qutlook

Microsoft Outlook creates a folder for each user profile.

All of these folders are placed inside the “Outlook Express 5.02:1dentities”
folder.

For instance, we have three users as well as three main folders: me, my
wife and my son. Inside each folder is the same structure: all emails are
stored in a single file named “Messages” and the Microsoft Database is
stored in a file called “Database”.

Creating new messages in Microsoft Qutlook Express increases the size of
these two files. When messages are deleted, Microsoft Outlook DOES NOT
reduce the size of these two files.

To reduce this free and wasted space, you have to compact the two files
using the following procedure:

Launch Microsoft Outlook Express holding down the option-key just before
the splash screen appears and until you see the following dialog.

Click on the button “Rebuild”.

Outlook Express

f YWould you like to compact the database?
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After some minutes, at the end of this task, you will see a dialog which
notifies you that all the files have been compacted successfully.

Now, you can check to see how much smaller the files “Message” and
“Database” are in the Finder.

Outlook Express

¥Your database was rehuilt, the old databhase and
messages file have been renamed "0ld
Database™ and "0ld Messages" respectively. They

can be thrown away.

Be sure that you have enough space on your Hard Disk, because Microsoft
Outlook Express used to duplicate and save the old and uncompacted files
naming them “Old Message” and “Old Database” respectively.

So, at the end of this task you should trash these old files.




Tips for Qutlook Email Archive

To obtain the best performance from OEA, we suggest you disable antivirus
programs (like Virex) by switching them off from their Control Panel, and if
you opened “FileMaker Pro”, quit it (it used to make the machine too
busy). The performances are increased also if you switch off Appletalk.

You can store the “OEA Finder Archive” in a Disk Image you created before
using utilities like “Apple Disk Copy”. Launch the “Apple Disk Copy”
program and select from the “Image” menu the command “Create New
Image”. A dialog will appear. Choose a name and size for your new “Disk”.

Image

Mount Image...

#M

Create Image from Folder... 31
Create Image from Disk.. 21

HK

Convert Image...

Save disk image as:

Kl

[ = Macintosh HD

0o

@ Outlook Express 5 13-01-2000
ﬁ System Folder 0z-06-2000
@ Unimel b.img 0g-07v-2000
& utilities Oggi
Name: IArl:hive of Year 2000.img I [W

Furmat:[ Read/Write s ]

Size: | 160 MB 2]

[ Mount Image [] Add DigiSign™ Signature

b4 Zero blocks

L
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Concerning the size you should assign to your disk: you should know that
the data extracted from Microsoft Outlook by OEA are

non-encoded, therefore the OEA data will use less space on the disk than
Microsoft Outlook did.

Click on the “Save” button and after a few seconds click on the “Erase”
button. The disk will be created and shown on your desktop.

B

Initialize disk image "Archive of Year
2000.img":

Archive of Year 2000

MName:

Format: [ Mac 05 Standard 160 MB

<]
[ Cancel "[ Erase ]

Switch to the OEA application and choose the new disk as the destination
disk/folder.



History Version

2.0

New interface.

Outlook Email Archive (OEA) is now compatible with the new MacOs 9.1

Is now possible to archive the subfolders or all structure in one session.
All the preferences are now saved.

Added support for saving files with the creator type for Alpha Text Editor.
The PDF manual has been revised. Sherlock section is better explained with
screen shot and examples.

1.9.9
The emails are now saved with the “Creator Type” chosen.
Added the “Append to tab-text file” feature.

1.9.5

User can now define the name and location of file created with the
functions “Export new text file” and “Export tab-text file”.

The routine “Export tab-text file” now removes possible TAB characters
from the fields From, To, Cc, Bcc, Attachments and Subject.

Minor internal optimization and changes.

Update of manual.pdf.

1.9

The routine “Export tab-text file” has been rewritten: now is 40% faster
(especially with emails with multiple addresses).

The date is now exported (in the “Export tab-text file”) as “real date” and
not as “text” date.

In case of errors OEA will not stop the execution but instead will write a
log file inside the OEA folder called “OEA Errors Log”.

The file menu is now disabled during the archiving process.

The textbox “Destination file for Archive:” is now disabled during the
archiving process.

The window “Report” has been redefined and now includes a count of the
number of errors.

OEA now checks, before starting the archiving process, to determine if
FileMaker Pro is open.

Numerous modifications have been made to the FileMaker Pro template
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“OEA Email DB” (now converted to FM Pro 5).
A free utility is enclosed in folder “Extra” for updating existing data
(generated with OEA before version 1.9) concerning the “date” in FM Pro.

1.8

Added the “skip emails” feature. There are three new check-boxes in the
Preferences area:

* Unread Emails * Flagged Emails * Edited Emails

The user can choose the destination folder/disk when archiving using
“Export new text file” and “Export tab-text file”.

The user can also archive the data using the MM-DD-YYYY date format
(see the Preferences).

In the unregistered version the user can process 9 emails (instead of
previous 6)

The manual.pdf has been updated with tips and suggestions for better use
of OEA and optimization of Microsoft Outlook Express.

1.7

Added window “Log” where OEA reports all the tasks executed.

Added four kinds of settings for date format in the window “Preferences”.
Added support for AppleWorks in the section “Creator Type”.

1.6

Added support for exporting with the functions “Export new text file -
Append to text file - Export tab-text” addresses related to “To”, “Cc”, Bec”.
Addresses are exported with display name and email address (e.g. John
Smith jsmith@aol.com).

Multiple addresses are supported.

Enhanced info during export progress.

Rewritten “Get info” routine. Now the progress bar is shown.

Minor changes of report window.

Optimized code.

1.5 Beta

Added support for exporting emails in tab-text format for quick importing
into FileMaker Pro (included is a free template).

OEA now supports export/append for long email messages (more than 32
Kb). Now the structure of folders and subfolders loaded from OEA in the



popup menu is in the same sequence as Microsoft Outlook Express
(including indentations).

Fixed the creator of Microsoft Word for export/append functions.
Fixed the received/sent date for export/append and export tab-text
functions.

Added “Preferences” window.

More than 40% of the code rewritten and cleaned.

For unregistered version user can process six emails (instead of previous 3).

Minor changes of the user interface.

1.4

Compatible with the last version of Microsoft Outlook Express 5.02.
Added support for generating a export TXT file with a creator of one of the
following applications (Teach Text, BBEdit, Tex-Edit Plus, MS Word);
choose from OEA menu the command “Creator Type for Export” and click
on icon.

During the archiving process all popup and textbox menus are now
disabled.

Added the name or names of attachments in the “Export TXT file” process.
When the user chooses from the popup menu a folder, the number of
emails are now shown in the left bottom corner of the OEA window.
Changed the display dialog about the export file.

Fixed a bug in the popup “Archive using” introduced in the 1.3 beta.

1.3 Beta

Added support for exporting all emails in one TXT file that can be viewed
with a text editor like BBEdit or Tex-Edit Plus.

User can append emails to an existing file or create automatically a new
one for each session.

Added support for exporting only attachments.

New Finder icon.

1.2

OEA now reads and supports the entire structure of folders and subfolders
in Microsoft Outlook Express without limiting levels. User can now chose
subfolder without switching between the programs.

Added popup menu for archiving emails based on received date or sent
date.

Added popup for archiving email + attachment or email only. During the
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archiving process the number of emails exported are now shown (e.g.
100/650).

In report window OEA now shows the elapsed time for performing the
operation.

Added message in report window when user deletes email (moves emails
in folder Deleted ltems).

The drag-over-destination-folder textbox now performs controls. Rewrote
and optimized routines.

Improved speed.

1.1

New “Report” window that informs the user about: total number of emails
found, emails archived, and emails skipped (because already archived).
Position of main window of OEA is now remembered at the next relaunch.
User can drag the destination folder over the icon or textbox of destination
folder (drag & drop).

User can now interrupt the archiving process pressing command-shift-
period.

OEA now check when the user presses button “archive” to see if Microsoft
Outlook Express in open.

Fixed bug that causes OEA report an error if user doesn’t select a
destination folder. Added button “Delete Emails” for moving all emails from
selected folder to folder “Deleted Items” in Microsoft OE.

Optimized code.

1.0
Initial Release.



About Registration and Pricing:
Outlook Email Archive has the following pricing:
single user license, $15 per user (US Dollars)

A Site License costs $200 and covers all locations for your organization
within a 160 kilometer (100 miles) radius of your site.

About Registration:

Paying for the Outlook Email Archive is fairly simple.

There are two methods.

On the Web (quick, easy and secure payment on-line) and by “Register”
application (off-line).

To register on the web:

Go to the web page http://order.kagi.com/?V8B

1 - Fill the form with your name, email, address, and how many copies you
want.

2 - Click on the button “Continue” and it will appear the invoice form.

3 - Fill the fields regarding your Credit-Card datas and then click on the
button “Purchase”. That's all.

If your browser supports, you can switch on SSL secure payment form
(it's the internet international standard secure form of payment).

Your invoice will be processed in 24 hours. Therefore, you will receive by
me via Email a little text file “Registration Code” to put inside the folder
“Outlook Email Archive”

To register off-line by the “Register” application:

Launch the “Register” application, enter your name, email address and
number of single user licenses or other licenses you desire.

Save or copy or print the data from the Register program and send the
data and payment to Kagi.

Kagi handles my payment processing.

See the end of this document for more specific payment information.
The fastest way (round 3 days) is to save the invoice to a text file,
choosing “via email,” and therefore send that text file via email as
attachment to sales@kagi.com. You can also open the invoice text file with
an editor (e.g. SimpleText) selects all the text, copy and paste into the
email so as it is (without any changement). Don't forget to include your
email address. We need to send to you the Registration Code by email.
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Once your message is received by Kagi, you will receive (in round 1-2
days) by me via Email a little text file “Registration Code” to put inside the
folder “Outlook Email Archive”.

Detailed Payment Info:

If paying with Credit Card or First Virtual, you can email or fax the data to
Kagi. Their email address is sales@kagi.com and their fax number is +1
510 652-6589. You can either Copy the data from Register and paste into
the body of an email message, or you can Save the data to a file and you
can attach that file to email message. There is no need to compress the
data file; it's already pretty small. If you have a fax modem, just Print the
data to the Kagi fax number.

Payments sent via email are processed within 1 to 2 days. You will receive
an email acknowledgement when it is processed. Payments sent via fax
take up to 10 days and if you provide a correct internet email address you
will receive an email acknowledgement.

If you are paying with Cash or USD Cheque you should print the data using
the Register application and send it to the address shown on the form,
which is:

Kagi

1442-A Walnut Street #392-V8B

Berkeley, California 94709-1405

USA

You can pay with a wide variety of cash from different countries but at
present if you pay via cheque, it must be a cheque drawn in US Dollars.
Kagi cannot accept cheques in other currencies.

If you have a purchasing department, you can enter all the data into the
Register program and then select “Invoice” as your payment method.

Print three copies of the form and send it to your accounts payable people.
You might want to highlight the line that mentions that they must include a
copy of the form with their payment.

Kagi cannot invoice your company, you need to act on my behalf and
generate the invoice and handle all the paperwork on your end.

Please do not fax or email payment forms that indicate Cash, Check or
Invoice as the payment method. As far as we know, there is still no



technology to transfer physical objects via fax or email and without the
payment, the form cannot be processed.

Payments send via postal mail take time to reach Kagi and then up to 10
days for processing. Again, if you include a correct email address, you will
hear from Kagi when the form is processed.

For any information about the software of for notify me bugs or enhancement:

Stefano Cappello

Email: capste@kagi.com

Web Site: http://digilander.iol.it/capste/

For further information about the payment:

Kagi - Email: sales@kagi.com Web Site: http://www.kagi.com
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